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Welcome to your Word Introduction training 

course 

 At the end of this course you will have a good working knowledge of 

Word basics 

 You will feel more confident using Word and be able to create a 

document from scratch 

 Understanding and using some of the built in layout and text editing 

functionality will enable you to produce far more striking and effective 

documentation in your work and home Word environments 

 Documents that you create will be easier to read and look more 

presentable

 

 



 

www.MicrosoftTraining.net 0207 987 3777 i 

Contents 

Unit 1: Getting Started ................................................................................. 1 

Elements of the Word window ....................................................................................................... 1 

Create a new document .................................................................................................................... 2 

Saving a document ............................................................................................................................. 2 

Using Help .............................................................................................................................................. 3 

Word 2016 ................................................................................................................................................................ 3 

Unit 2: Editing Documents ........................................................................... 4 

Open a document ............................................................................................................................... 4 

Navigating a document using the scroll bar ............................................................................. 5 

Navigating a document using the keyboard ............................................................................ 5 

Using Go To ........................................................................................................................................... 6 

Edit text in a document ..................................................................................................................... 6 

Autocorrect feature ............................................................................................................................. 7 

Find and Replace ................................................................................................................................. 7 

Unit 3: Moving and Copying Text ............................................................... 8 

Selecting text using the mouse ...................................................................................................... 8 

Select a word ........................................................................................................................................................... 8 

Select a paragraph ................................................................................................................................................. 8 

Select several paragraphs ................................................................................................................................... 8 

Selecting text using the keyboard ................................................................................................. 8 

Select a line............................................................................................................................................................... 8 

Select a paragraph ................................................................................................................................................. 8 

Move or copy text using the mouse ............................................................................................ 9 

Move or copy text using Cut, Copy and Paste ........................................................................................... 9 

Unit 4: Formatting Characters and Paragraphs ....................................... 10 

Applying character formatting – font and font size .............................................................10 

Shortcut keys ........................................................................................................................................................ 11 

Other character formats ..................................................................................................................11 

From the Font dialogue box effects such as: ........................................................................................... 11 

Using paragraph formats ................................................................................................................12 

View paragraphs .................................................................................................................................................. 12 

Paragraph alignment ........................................................................................................................12 

To change alignment: ........................................................................................................................................ 12 

Indentation ...........................................................................................................................................13 

Line spacing ........................................................................................................................................................... 14 

Bullet and numbering ......................................................................................................................14 

To apply bullets or numbering: ..................................................................................................................... 14 

Tabs – viewing the ruler ..................................................................................................................14 



ii 0207 987 3777  www.MicrosoftTraining.net 

Types of tabs .........................................................................................................................................................15 

Left tab .....................................................................................................................................................................15 

Right tab ..................................................................................................................................................................15 

Centre tab ...............................................................................................................................................................15 

Viewing tabs........................................................................................................................................ 15 

To view tabs on the screen: .............................................................................................................................16 

Working the tabs dialogue box......................................................................................................................16 

To change current tab settings, or remove tabs: ....................................................................................16 

Unit 5: Creating and Managing Tables ..................................................... 17 

Insert a table ....................................................................................................................................... 17 

To create a table: ..................................................................................................................................................17 

To add text: ............................................................................................................................................................17 

Inserting rows or columns ............................................................................................................. 18 

To insert additional rows or columns into a table: .................................................................................18 

Deleting rows or columns .............................................................................................................. 18 

To delete rows or columns from a table: ...................................................................................................18 

Using AutoFit options ..................................................................................................................... 19 

AutoFit options are used to adjust the size of the table columns automatically. ......................19 

Changing cell text alignment ....................................................................................................... 19 

Unit 6: Controlling Page Layout ................................................................ 20 

Accessing the header or footer ................................................................................................... 20 

To access the header or footer:......................................................................................................................20 

Editing the header or footer ............................................................................................................................20 

Navigating and inserting page numbering ...............................................................................................21 

Changing document margins ....................................................................................................... 22 

Inserting a page break .................................................................................................................... 22 

To insert a page break: ......................................................................................................................................23 

Delete a page break ............................................................................................................................................23 

Unit 7: Using Proofing Tools ..................................................................... 24 

Using the spelling and grammar checker ................................................................................ 24 

Spelling and grammar checking options ...................................................................................................25 

Using the thesaurus ......................................................................................................................... 25 

To look up/use an alternative word: ............................................................................................................26 

Unit 8: Web Features .................................................................................. 27 

Creating a hyperlink ......................................................................................................................... 27 

To create a hyperlink: .........................................................................................................................................27 

Emailing a document from Word (using Outlook) ............................................................... 28 

Save a document as a web page ................................................................................................ 29 

Quick reference: Word shortcut keys ....................................................... 30 

 



 

www.MicrosoftTraining.net 0207 987 3777 1 

Unit 1: Getting Started 

In this section you will learn to: 

Explain the elements of the Word window  

Create and save documents  

Access and use Help  

Elements of the Word window 

 

1.  File Tab (Backstage) 7. Group of buttons 

2.  Quick Access Toolbar 8. Ruler 

3.  Title bar 9. New document 

4.  Minimise Window 10. Vertical scroll bar 

5.  Tabs 11. Status bar 

6.  Ribbon   

1 

5 
6 7 

8 
9 

11 

10 

2 3 4 
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Create a new document 

File Tab  New, or Ctrl + N 

Blank document 

Create 

Saving a document 

File Tab Save, or Ctrl+S 

Select Location to save to  

Enter filename 

Save 

Use Ctrl+S to save additional changes made to your document 
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Using Help 
 

 

Click ? or press F1 to launch Help 

Word 2016 

Word 2016 has the Tell Me search bar where you can describe the function or 

feature you need: 
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Unit 2: Editing Documents 

In this section you will learn to: 

Open and move around a document  

Use Word’s AutoCorrect feature  

Edit text in a document  

Use the Undo and Redo commands  

Search for and replace text 

Open a document 
 

 

File Tab  Open, or Ctrl+O 

Select the Location the file is saved in 

Click on the file once 

Open 



 

www.MicrosoftTraining.net              0207 987 3777                                        5 

Navigating a document using the scroll bar 
On the vertical scroll bar, click up or down arrows, or click on and drag place marker 

Navigating a document using the keyboard 

Page Up 
Move up the document 

(toward first page) 

Page Down 
Move down the document 

(toward last page) 

Home 
Move to start of a line 

End  
Move to the end of a line 

Ctrl+Home 
Move to the start of the document 

Ctrl+End 
Move to the end of the document 
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Using Go To 

Home tab FindGo to 

or Ctrl+GSelect Page on left 

Enter page numberGo To 

Edit text in a document 
 

Backspace 
Remove the character to the left of the cursor 

Delete 
Remove the character to the right of the cursor 

Overtype 
Replaces text as you type 

Turn off or on by pressing Insert key or double-click on the letters OVR in the 

status bar at the bottom of the screen 

Undo and Redo 

 

Both buttons are located on the Quick Access toolbar. 

Undo reverses the previous action taken, shortcut is Ctrl+Z 

Redo repeats actions that have been undone, shortcut is Ctrl+Y 
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Autocorrect feature 
To view existing AutoCorrect entries: 

Go to Insert tabSymbols group 

Click Symbol and select More SymbolClick AutoCorrect 

To create an entry: 
Type mis-spelt entry into Replace box, and correctly spelt entry into With 

box 

Click OK. 

Find and Replace 
Home tabEditing group 

Use Find to search for a word; or Replace to replace one word with another 

Use shortcut keys Ctrl+F for Find 

Ctrl+H for Replace 
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Unit 3: Moving and Copying Text 

In this section you will learn to: 

Select text by using the mouse and keyboard 

Copy and move text  

Selecting text using the mouse 
 

Select a word 

Double-click on the word 

Select a paragraph 

Triple-click within the paragraph 

Select several paragraphs 

From left margin using 

Selecting text using the keyboard 
 

Select a line 

Ctrl+End (cursor positioned at start of line), or 

Ctrl+Home (cursor positioned at end of line) 

Select a paragraph 

Ctrl+Shift+Down Arrow (cursor positioned at start of paragraph), 

or 

Ctrl+Shift+Up Arrow (cursor positioned at end of paragraph) 

Select whole document 

Ctrl+A 
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Move or copy text using the mouse 
 

 

 

To move select text, then click on the text and drag to the new location. 

To copy select text, then hold down the Ctrl key. 

Click on the text and drag to the new location. 

Move or copy text using Cut, Copy and Paste 

Select text 

Home tabClipboard group 

To move, select Cut or Ctrl+X 

To copy, select Copy or Ctrl+C 

Position cursor where the text is to go 

Select Paste or Ctrl+V 
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Unit 4: Formatting Characters and Paragraphs 

In this section you will learn to: 

Use character formatting to enhance text  

Use basic paragraph formatting to enhance a document’s appearance 

Use tabs in a document  

Applying character formatting – font and font size 
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Select the text to be formatted 

Home tabFont groupselect font or font size 

Shortcut keys 

Select text and use 

Ctrl+] to increase font size by 1pt 

Ctrl+[ to decrease font size by 1pt 

Other character formats 

 

Select the text to be formatted 

Home tabFont groupclick  in bottom right of Font group 

 

From the Font dialogue box effects such as: 

Strikethrough 

Superscript 

Subscript 

Shadow 

can be applied. 
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Using paragraph formats 

 

Paragraph formatting commands can be found on the 

Home tabParagraph group. 

View paragraphs 

 

Click the Show/Hide button in the Paragraph group to reveal paragraphs and other 

non-printing characters in a document. 

Paragraph alignment 
 

 

Left alignment 

Ctrl+L 

 

Right alignment 

Ctrl+R 

To change alignment: 

Select the paragraph(s) to be aligned. 

Click an alignment button in the Paragraph group. 

 

Centre alignment 

Ctrl+E 
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Justify alignment 

Ctrl+J 

 

 

 

 

Indentation 

 

To change indentation: 

Select the paragraph(s) to be indented. 

Click an indentation button (Decrease Indent or Increase Indent) in the 

Paragraph group. 
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Line spacing 

 

To change line spacing: 

Select the paragraph(s) to apply line spacing to. 

Select line spacing using the dropdown arrow next to Line Spacing button. 

 

Bullet and numbering 

 

To apply bullets or numbering: 

Select the paragraphs to be bulleted or numbered. 

Click the Bullets button or Numbering button to apply. 

Tabs – viewing the ruler 

 

Ensure the ruler is visible near the top of the screen: 

View tab tick Ruler checkbox in Show group. 

Selecting a tab type 
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To select a tab type, click on the tab button to the left of the ruler to cycle through 

different tab types. 

Types of tabs 

Left tab 

Text starts at the tab position and flows to the right as you type. 

To set a tab: 

1. Select the tab type at the left of the ruler. 

2. Click on the ruler at the point where the tab is to be positioned. 

3. Press the Tab key to shift the cursor to the tab position; and begin typing. 

 

Right tab 

Text starts at the tab position and flows to the left as you type. 

 

 

 

 

Centre tab 

Centre of the text is at the tab position. 

 

 

Viewing tabs 
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To view tabs on the screen: 

Go to the Home tabParagraph group. 

Click the Show/Hide button. 

Tabs will show as small arrows. 

Working the tabs dialogue box 

 

 

To change current tab settings, or remove tabs: 

Double-click on a tab marker on the ruler. 

Select the tab stop to be altered or removed from the list of tab stops on 

the left. 

Now the alignment for the selected tab can be changed; or the tab can be 

cleared. 
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Unit 5: Creating and Managing Tables 

In this section you will learn to: 

Create tables in a Word document  

Edit the structure of tables 

Enhance the appearance of tables   

Insert a table 
 

 

 

To create a table: 

Go to the Insert tabTable button. 

Select the number of cells to be included by dragging the mouse over the 

grid; 

or 

Select Insert Table. 

 

To add text: 

 Click in a cell and type. 

Press Tab to move to the next cell. 
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Inserting rows or columns 
 

 

To insert additional rows or columns into a table: 

Click in a cell next to where the row or columns is to be added. 

Go to the Table Tools Layout tabRows & Columns group. 

Click the appropriate Insert button. 

 

 

 

Deleting rows or columns 
 

 

To delete rows or columns from a table: 

Click in a cell within the row or column is to be deleted. 

Go to the Table Tools Layout tabRows & Columns group. 

Click the appropriate Delete option from the dropdown arrow next to Delete. 
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Using AutoFit options 
 

 

AutoFit options are used to adjust the size of the table columns 

automatically. 

Click in a cell within the table. 

Go to Table Tools Layout tabCell Size group. 

Click the dropdown arrow next to the AutoFit button to select an AutoFit 

option. 

 

Changing cell text alignment 
To align text within a cell: 

Click in the cell containing the text, or 

select the column or row. 

Go to Table Tools Layout tabAlignment 

group. 

Select the alignment option to be used. 
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Unit 6: Controlling Page Layout 

In this section you will learn to: 

Add headers and footers to a document  

Set and change the margins for a document  

Add and delete manual page breaks  

Accessing the header or footer 
 

 

To access the header or footer: 

Go to Insert tabclick Header button or Footer button. 

Select a built-in option 

or 

Select Edit Header or Edit Footer. 

Editing the header or footer 
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Type into the header or footer, then use the Tab key to move across to the next 

tab stop position. 

Navigating and inserting page numbering 

 

On the Header & Footer Tools/Design tab: 

Use the Go to Footer or Go to Header button to navigate between the two 

areas 

Use the Page Number button to insert page numbering 

Click Close Header and Footer to exit. 

  
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Changing document margins 
 

 

 

To change a document’s margins: 

Go to Page Layout tabPage Setup group. 

Click the Margins button. 

Select from preset margin options; or use Custom Margins to enter margin 

sizes. 

Inserting a page break 
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To insert a page break: 

Click the cursor where the page break is to be positioned. 

Go to the Page Layout TabPage Break button.  

Shortcut keys: Ctrl+Enter to insert a page break. 

Delete a page break 

 

 

 

 

Turn on the Show/Hide button (Home tab 

Paragraph group). 

Click the cursor to the left of the page break. 

Press the Delete button on the keyboard. 

 

Delete 
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Unit 7: Using Proofing Tools 

In this section you will learn to: 

Use Word’s Spelling and Grammar feature to proof a document  

Use Word’s Thesaurus to find alternative words  

Using the spelling and grammar checker 

 

To launch the Spelling and Grammar checker, go to Review tabSpelling & 

Grammar button 

 

To ignore the suggestion, click Ignore Once or Ignore All. 
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Use Add to Dictionary to add a correctly spelt word to Word’s dictionary (so the 

word won’t come up as an error in future). 

To correct an error to a suggested option, click Change or Change All. 

Spelling and grammar checking options 

 

 

To change spelling and grammar options, go to File TabProofing category. 

Using the thesaurus 
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To look up/use an alternative word: 

Right-click on the word. 

Go to Synonyms and select another word to replace the one currently 

used. 
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Unit 8: Web Features 

In this section you will learn to: 

Saving documents as web pages 

Working with hyperlinks 

Emailing documents  

Creating a hyperlink 

 

 

To create a hyperlink: 

Select the text that is to become a hyperlink. 

Go to the Insert tabLinks group. 

Click the Hyperlink button. 

Create hyperlink settings using the Insert Hyperlink dialogue box. 

Click OK. 

Use Ctrl+Click to test the hyperlink. 

 

Shortcut keys: 

Ctrl+K to access Insert Hyperlink dialogue box. 
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Emailing a document from Word (using Outlook) 
 

 

 

To email an open document from Word using Outlook: 

Go to File TabshareEmail. 

A new Outlook email message opens, with the open Word file attached. 

Enter recipients’ email addresses and send. 
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Save a document as a web page 
 

 

 

Go to the File TabSave As 

Save As Type 

Select Web Page as the file type under Save as type. 

Save. 

 

E&OE 

STL Training reserves the right to revise this publication and make changes from 

time to time in its content without notice. 
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Quick reference: Word shortcut keys 

Command Keystroke 

Bold Ctrl+B 

Close Ctrl+F4 

Copy Ctrl+C 

Cut Ctrl+X 

Exit Word Alt+F4 

Font Ctrl+D 

Font grow/shrink 1 pt. Ctrl+ ] or [ 

Help F1 

Help—What’s This? Shift+F1 

Hyperlink Ctrl+K 

Italics Ctrl+I 

Justify—Center Ctrl+E 

Justify—Full Ctrl+J 

Justify—Left Ctrl+L 

Justify—Right Ctrl+R 

Line-spacing 1 Ctrl+1 

Line-spacing 1.5 Ctrl+5 

Line-spacing 2 Ctrl+2 

List Bullet Ctrl+Shift+L 

New document Ctrl+N 

Open a document Ctrl+O 

Paste Ctrl+V 

Print Ctrl+P 

Print Preview Ctrl+Alt+I 

Repeat/Redo Ctrl+Y 

Underline Ctrl+U 

Underline—double Ctrl+Shift+D 

Save Ctrl+S 

Select All Ctrl+A 

Spelling and Grammar check F7 

Table—to column bottom Alt+PgDn 

Table—to column top Alt+PgUp 

Table—to row beginning Alt+Home 

Table—to row end Alt+End 

Undo Ctrl+Z 

 


